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2 - Disclaimer
The software and documentation is Copyright © Navegar Foundation
Software License and Copyright
This License allows you to use one copy of the Software on a single computer at a time. You may use as many copies of
the Software as you have licenses for.
The Software contains trade secrets in its human perceivable form and, to protect them, you may not reverse engineer,
decompile, disassemble, and otherwise reduce the software to any human perceivable form. You may not modify, adapt,
translate, rent, lease, loan, resell for profit, or create derivative works based upon the software or any part thereof.
This manual and accompanying software are copyright protected. No part of this document may be translated, reproduced, stored on a retrieval system or transmitted in any form or by any means, electronic or mechanical, for any purpose,
without the express written permission of Navegar Foundation.
This manual, as well as the software described in it, is furnished under license and may be used or copied in accordance
with the terms of such license. The content of this manual is furnished for information use only, is subject to change without notice and should not be construed as a commitment by Navegar Foundation.
Liability
Although every precaution has been taken in the preparation of the program and this manual, Navegar Foundation assumes no responsibility for errors or omissions, neither is any liability assumed for damages resulting from the use of the
program or from the information contained in this manual.

Contacts:
plugin@multimeios.pt

Web Page:

fulldomeplugin.multimeios.pt

Fulldome, Compositing Packages Plugin
Version 3.0
Copyright Navegar Foundation 2006
Plugin design - António Pedrosa, Luís Calçada
Programming - Marco Silva
Manual - Luis Calçada, António Pedrosa
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3 - Installation
3.1 - Plugin Installation
The FullDome Plugin for After Effects is distributed in a DVD case containing:
- A DVD with the software.
- An activation dongle.
To install the software, the procedure is similar both for PC and Mac:
- Insert the DVD in the computer drive.
- Unzip the file Fulldome_Full.zip.
- Extract fulldome_full in to Adobe After Effects Plugins folder.
- Insert the USB Protection Dongle.
- Start After Effects.
The user should take care in reading the ReadMe file, distributed along with the software, with the latest details regarding the installation.

3.2 - Dongle Installation
In case the Dongle distributed along the software is the Rockey4ND model then no driver installation is required. For the
previous Dongle model, Rockey4, please follow the instructions available in the previous version of this manual.

3.3 - Windows OS update
For users under Windows, do please check if the OS is updated. There is an update, that is not mandatory for windows,
but needed to run the plugin. The update is the following:
http://www.microsoft.com/downloads/details.aspx?familyid=766A6AF7-EC73-40FF-B072-9112BAB119C2&displaylang=en
Both 32bit and 64bit OS must install the 32bit update.

3.4 - System Requirements
Adobe After Effects 7.0 or above (as of version 1.2 only Adobe After Effects is supported, but support for other compositing packages is planned.)
PC Requirements:
Vista, Windows XP,
1.5GHz processor
512 RAM
USB Port
CD Drive

Mac Requirements:
Mac OS 10
512 RAM
USB Port
CD Drive
Xcode installed (needed to detect dongle)

3.5 - Hardware Recommendations
In order to retrieve the most from the capabilities of the Fulldome Plugin, its recommended that whenever possible users run the plugin in a computer with a modern Nvidia Graphics Card.
Before running the software, users should install the latest CUDA driver and toolkit, that are available on the download
link of the CUDA Nvidia website.
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4 - Introduction
Fulldome for Adobe After Effects is a plugin that converts the standard rectangular workspace into a spherical or cylindrical workspace. This allows the user to easily produce content for spherical screens, such as planetarium domes, which can
occupy all 360ºx90º of the spectator field of view, or even the entire 360ºx180º.
The workspace in Fulldome is a projection of the spherical screen, usually a circular one. The basic reference coordinates
are now angular.
Fulldome also converts the standard rectangular workspace into a panoramic one, allowing the user to have a different
view of the content produced, or producing content for panoramic projection. In this case, the Master Projection selected
(see Section 7.2.1) is cylindrical and the workspace becomes a rectangular one.

a)

b)

c)

Figure 4.1. a) After Effects standard rectangular workspace. b) Azimuthal Equidistant (fisheye) workspace under Fulldome Plugin. c)
Cylindrical (Panoramic) workspace under Fulldome plugin.
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Fulldome manages all the transformations and projections of the media content (whether video, images or text), which
now have their positions referenced in angular coordinates instead of the typical rectangular ones, although these are also
available.
The plugin also possesses a set of astronomical features, as since potential users will be digital planetarium show producers. So Fulldome allows the user, if desired, to input a date, time and location, and from there on to reference his media
contents in astronomical coordinates in the celestial sphere.

4.1 - Main Features:
- Several output Master Projections, 9 in total.
- Several Input Projections, 14 in total.
- Real time interaction.
- Coordinates: layers can be referenced in workspace, dome or celestial sphere coordinates.
- Astronomical algorithms: simulate the movement of the celestial sky for any given date and location.
- Several image orientation options.
- All parameters are animated.
- Stitching images and video.
- Hyperdome ready: display from 0º to 360º in your full dome workspace.
- User can select the dome tilt.
- Horizon can be raised or tilted.
- Several image interpolation methods are available for better image quality.
- Supports network rendering.
- GPU acceleration for increased performance.
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5 - Interface
The interface is divided in 5 major groups, namely Dome, Projections, Image Parameters, Astronomical Parameters
and Options. By default all the parameters are hidden. They become accessible by clicking on the different group flags
. The Astronomical Parameters are only available if their use is selected in the selection box.
By clicking on the successive group flags, an increasing number of parameters become available, see Figure 5.1.

a)

b)

c)

Figure 5.1: Plugin interface. a) Parameters hidden under different parameter group (default). b) Normal view with the astronomical
parameters disabled. c) Detailed view, with the astronomical parameters enabled. Several projection parameters are hidden, becoming
visible once the corresponding projection is selected.
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6 - Workflow
6.1 - Basic use of the plugin
To start preparing content using the plugin, the user should:
- Create a composition, with equal width and height, and a square pixel aspect ratio, Figure 6.1a. A preset in the
composition types can be created for future use.
- Import an image or movie and drag it onto the composition, creating a layer, Figure 6.1b.
- Apply the plugin to that layer, by selecting Effect > Navegar Foundation > Fulldome, see Figure 6.1c.

a)

b)

c)

Figure 6.1: Synthesis of the workflow when using Fulldome: a) Create composition (square), with square pixels. b) Import file into the
composition. c) After applying the plugin.

Now the workspace for this layer has been converted to an hemispherical space.
The master projection is by default Azimuthal Equidistant, or Fisheye, that is the standard projection used in fulldome
content production. After applying the plugin to a layer, the image projection type should be selected, which by default is
set to Gnomonic (usually referred as the standard projection).

Figure 6.2: The user can choose from many Master and Image
Projection types.

At this point the user can start composing, by changing the different parameters, like Altitude and Azimuth, setting the
size, inserting new layers, etc (see section 8).

6.2 - Global Parameter Setting
When further layers are added, further instances of the plugin must be applied to them and care must be taken since some
parameters should be kept global. Some examples are the Dome tilt, Master projection, Spherical angle, Latitude and
Longitude of the observer if the astronomical parameters are used. This should be done for sake of coherence and can
easily be achieved by setting up a very simple expression in After Effects.
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When setting a parameter global, there will be a layer driving that parameter. In order to set a parameter global, the Master projection for example, the user just need to:
- Create a layer; apply the plugin;
- Create another layer and apply the plugin.
- From the timeline, select the Master Projection parameter from the driven layer by clicking on it, and from the
menu bar, choose Animation > Add Expression.
- Now click
and drag it to the Master Projection parameter of the layer that will be driving.
The parameters from the two instances of the plugin are now linked, thus ensuring that if the value is changed in the one
driving, the other instance of the plugin, the slave, will be changed as well, guaranteeing consistency, see Figure 6.3. The
user can save this effect as an Animation Effect, in Animation > Save Animation Effect for a repeated use in the following
instances of the plugin, avoiding the need to repeat all the steps regarding the global parameter setting, see section 6.3.

a)

b)

c)

Figure 6.3: Setting up an expression to connect a parameter in two instances of the plugin, the Master Projection. a) Selection the
parameter. b) From the Menu, Animation > Add Expression was chossen. c) Expression added, showing that this instance parameter is
driven by the instance applied to Driver.jpg.

6.3 - Animation Preset
When the complexity of a project is large, it is very useful to the use Animation Presets, avoiding the need to repeatedly
set up a new instance of the plugin. Once saved, to apply the plugin the user just need to invoke the preset available under
“Animation > Apply Animation Preset...”, see Figure 6.4 (Left).
A good example is setting up Global Parameters, like described in the previous section for the Master Output projection. Once the procedure described is completed for the first time, saving the preset under “Animation > Save Animation
Preset...” avoids the need to repeat the entire process of setting the Master Output as a Global Parameter, each time the
plugin is applied.
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However care must be taken in order to make the Fulldome presets universal, that is, usable by any layer. The parameters
that are not linked by an expression will keep the same value of the plugin at the time when the preset was created. This
raises an important issue with the Anchor Point parameter, see section 7.3.5.
By default the Anchor Point is set to the centre of the layer. If a preset is saved, and then applied to new a layer, the Anchor Point will be set, not to the centre point of the new layer, but to the centre of the layer where the preset was saved.
If the new layer has a different size, the Anchor Point wont be at the centre as it should.
To make the preset universal, before saving it, the user should insert an expression that sets the Anchor Point parameter
to the centre of the layer, using the following procedure:
- From the timeline, select the Anchor Point parameter.
- From the menu bar, choose Animation > Add Expression.
- Type the following expression “[thisLayer.width/2 , thisLayer.height/2]“.
- Save the preset by chosing Animation > Save Animation Preset...
Once done, an expression is displayed in the time line, see Figure 6.4 (Right). From now on, when applying the preset,
the plugin will take in account the size of the new layer and set the Anchor Point to its centre.

Figure 6.4: Left - Saving or applying a Preset is done through menu “Animation > Save Animation Preset ...” or “Animation > Apply
Animation Preset ...” respectively. Right: Setting up an expression on the Anchor Point parameter, in order to make the preset universal, that is, usable with any footage size.
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7 - Plugin Parameters
The plugin has five major parameter groups:
- Dome
- Projections
- Image Parameters
- Astronomical Parameters
- Options
Figure 7.1: Plugin parameter groups as they show up in the
effects control window.

7.1 - Dome
The parameters under this group set the Dome characteristics,
namely:
- Horizon raise
- Horizon tilt
- Dome tilt
- Spherical Angle
- North direction
In most cases these parameters should be kept global, see Section 6.2.

Figure 7.2: The parameters under the Dome group flag as
they show up in the effects control window.

7.1.1 - Horizon Raise
Is the amount of degrees that the horizon is raised. Increasing
this parameter, all the horizon is raised equally. In case of horizontal domes, for example, raising the horizon means that the
0º altitude will be above the spring line. In the case of using
a value of 15º, points up to -15º that otherwise were below the
spring line are now visible. By default the value is 0º.

Figure 7.3: The Horizon raise parameter was set to 15º, showing the horizon
line (red) above the spring line.
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7.1.2 - Horizon Tilt
Measured in degrees (º), is the amount by which the horizon is
tilted. Increasing the horizon tilt results in bringing the Southern
horizon up while lowering the North. By default is set to 0º.

Figure 7.4: The Horizon Tilt set to 15º,
showing the horizon line (red) 15º above the
spring line on the South and the North is below the spring line.

7.1.3 - Dome Tilt
Measured in degrees (º), is the angle by which the planetarium
dome is tilted. By default is set to 0º. The value can vary between 0 and 360º.

Figure 7.5: A 15º tilted dome. In the
workspace image is possible to see a shift of
the Zenith in the northern direction (up).

7.1.4 - Spherical Angle
This parameter defines the angular size of the dome, in altitude (from horizon to zenith to horizon). The default, and
standard is 180º which is an hemisphere. For several master projections an hyperdome can be set up, with spherical angle
up to 360º.

Figure 7.6: Spherical Angle. On the left a standard 180º dome. On the right, a 270º hyperdome.
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Care should be taken, since according to the Master Projection, the maximum Spherical Angle varies:
- Azimuthal and Cylindrical: from 0º to 360º.
- Gnomonic: less then 180º.
- Stereographic: less then 360º.
- Orthographic: up to 180º.
- Vertical: less then 360º, depending on the value of the escape point (see section 7.2.2).
7.1.5 - North Direction
This parameter defines the North direction in the workspace. By default (0º), it is the direction up on the workspace (for a
circular master projection), in agreement with the full dome standards. If set to 90º, North would be towards the left region
of the workspace, for 180º down and for 270º it will be on the right side of the composition.
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7.2 - Projections
Under this group, the projections for the master and image are
selected. Some of these parameters, like the Master Projection,
should be kept global, since they are the same for all layers.
Some of the projections when selected show parameters that
otherwise are hidden. These are Azimuthal Equidistant-off axis,
in the Master Projection, the Vertical Perspective and Spherical
Mirror, present both on Master and Image Projection.

Figure 7.7: Set of parameters available after selecting the
Projection group flag.

7.2.1 - Master Projection
Selects the projection of the master. This is how the projection
screen is represented in the workspace. By the default, and according to the Fulldome standards it is set to Azimuthal Equidistant or Fisheye.
The available options, 9 in total, are:
- Azimuthal Equidistant
- Azimuthal Equidistant Off-Axis
- Gnomonic
- Stereographic
- Orthographic
- Vertical Perspective
- Cylindrical Equidistant
- Cylindrical Equal Area
- Spherical Mirror

Figure 7.8: Set of Master Projections available.

Two of the projections are unconventional, the Azimuthal Equidistant Off-Axis and the Spherical Mirror. The first one
represents an Azimuthal Equidistant projection of a sphere, with the centre of projection not coincident with the centre
of the sphere. In practical terms, it represents the way that a fisheye lens sees the dome, when it is located off-centre. The
former corresponds to the required projection to project content on a dome with the use of a Spherical Mirror. For further
details see Appendix A.

Figure 7.9: Two different master projections. Left: Azimuthal Equidistant. Right: Cylindrical Equidistant. The composition in this example has two layers where both master projection parameters are connected via an expression. Switching between projections is done
by changing this parameter in the driving layer (Panoramic image, courtesy of Mario Di Maggio, ThinkTank).
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7.2.2 - Image Projection
Selects the layer projection, the default is Gnomonic. The user should select the corresponding projection used to create
the layer. When for example, the user wants to insert footage that is a photograph or a video obtained with a camera with a
standard lens, the projection selected should be Gnomonic, while a panorama image, one of the cylindrical or panoramic
projections should be selected.
The available options, 14 in total, are:
- Azimuthal Equidistant
- Aitoff
- Hammer-Aitoff
- Gnomonic
- Stereographic
- Orthographic
- Vertical Perspective
- Cylindrical Equidistant
- Cylindrical Equal Area
- Centre Cylindrical
- Panoramic Equidistant
- Panoramic Equal Area
- Centre Panoramic
- Spherical Mirror
All projections are standard. The panoramic ones are special cases of the corresponding cylindrical, where the image are
always parallel to the horizon. See Appendix B for detailed information regarding the image projections.
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7.3 - Image Parameters

This is a set of parameters, that include location on the dome,
rotation, scale and reference points, used to define and place
the layer in the composition.

Figure 7.10: Set of parameters available after selecting the Image Parameters group flag.

7.3.1 - Altitude, Azimuth
Defines the angular position of the layers on the dome reference frame. Both parameters are expressed in degrees. If the
Extended Degrees option in the Options Tab (see below) is enabled, user can input degrees, minutes and seconds:
- Altitude is measured from the horizon (the spring line for a 180º dome), positive above, and varies between -90º
(Nadir), 0º (Horizon) and 90º (Zenith).
- Azimuth is measured in clockwise direction from the North, and goes from 0º (North) to 180º (South) and 360º
(North). By default for the azimuthal projections, north is up while south is down. For the cylindrical ones, South
is in the middle and North on the extremes of the composition.

Figure 7.11: Altitude and Azimuth in the workspace and in 3D space. Altitude is measured
from the horizon, positive above, while Azimuth is measured clockwise from the North, that
by default is up.

7.3.2 - Rotation
Measured in degrees, this parameter defines the rotation of the layer about it’s anchor point. Positive in anti-clockwise

Figure 7.12: By default the images are connected to the observer and oriented
to the Zenith. In special cases, images located in the Zenith or Nadir, they are
oriented to the South.

direction. By default, the images are Linked to the Observer and oriented to the Zenith. In the special case of an image
located at the Zenith or Nadir, the images are oriented to the South.
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7.3.3 - Resampling
This parameter selects the resampling method used to reconstruct the image. The user can select between the following resampling methods:
- Nearest neighbour (1x1)
- Bilinear 2x2
- Bicubic (4x4, -0.5)
- Bicubic (4x4,-0.75)
- Bicubic (4x4,-1.0)
- Spline (4x4)
- Spline (6x6)
- Quintic (6x6, 3/64)
- Lanczos (4x4)
- Lanczos (6x6)
- Blackman (4x4)
- Blackman-Harris 3term (4x4)
- Gaussian (4x4)
- Hamming (4x4)

Figure 7.13: List of Resampling methods available.

The selection of the resampling method is usually a trade off between speed and image quality. The increase in the resampling matrix (1x1), (2x2) up to (6x6) usually brings better results in the expense of speed. For most cases a bicubic
resampling is enough.
7.3.4 - Scale
Along with rotation, the scale of a layer, from the moment on
that the plugin is applied, should be set here and not on the
Transform tab, present in the timeline, because those are disable since the plugin takes over the management of these two
parameters.
Full Width Scale
Available for Cylindrical and Panoramic image projections.
This option forces the layer to completely surround the dome,
that is, its width becomes 360º, see Figure 7.16.
Lock Aspect Ratio
Lock the ratio between the layer width and height (by default
Scale is selected). The options are:
- Off: Changing one dimension does not alter the other.
- Scale: Changing one dimension, the other is changed,
keeping the same proportion in percentage.
- Angular: Changing one dimension, the other changes
keeping the same angular proportion.
Scale Width & Height
Sets the width and height of the image, in percentage, relative to
the original image. By default these values are set to 100%.

Figure 7.14: Selecting the Scale flag, several parameters are displayed, including the Scale and Angular
size.

Figure 7.15: Full Width Scale. This option forces the
cylindrical layer to completely surround the dome.

Angular Width & Height
Sets the angular width and height of the image in degrees. These
values correspond to the lengths of the arcs that crosses the image in both directions, and go though the anchor point. By default, they display 90º on both dimensions, but in reality they are disactivated. To activate these parameters and obtain the
true angular dimensions, the Angular Width or Height parameters need to be changed, once the plugin is applied.
Angular Width and Height have maximum values of 360º, and are disabled if the Anchor point is outside the image limits
(see below).
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7.3.5 - Reference Points
These parameters enable the positioning of a image and its anchor point in the composition, using the rectangular coordinates
and always referenced to the initial reference frame of the image
itself.
Position
Sets the position of a layer in the rectangular coordinates of the
workspace. When the
symbol is clicked, a crosshair appears
in the workspace that lets the user select the layer position manually. The Altitude and Azimuth are updated accordingly.
Remember also that you can click the symbol
and position
the layer by dragging it in real-time in the workspace, see Figure
7.18.
Anchor Point
The Anchor point is the layer image point that is tangent to the
dome, see Figure 7.19. By default, being the usual case, its the
central point, but by clicking the symbol
, a crosshair will
appear in the workspace and any point can be chosen as anchor.
This point is referenced in the layer’s own coordinate system,
which is represented in the workspace. If a layer is for example
300x300 pixels, the top left corner is the origin (0,0) and the
right lower corner is the (299, 299) point. Any point outside the
image can also be chosen as an anchor point.

Figure 7.16: Selecting the Reference Points flag,
both Position and Anchor points coordinates are displayed.

Figure 7.17: Drag the image in real time by clicking in
the cross above the image.

Figure 7.18: The Anchor point is referenced in the layer’s own coordinate system, which can be seen in
the left image as the 9 dots in the centre of the workspace. These serve only as reference. On the right,
the anchor is the point where the layer is tangent to the dome. For a cylindrical image projections it
represents the centre of the line tangent to the dome.
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7.4 - Astronomical Parameters
The use of Astronomical Parameters is mainly devoted to the use of the plugin for a planetarium production content. It
relates the local reference frame attached to the observer or dome, the Horizontal System, to a Celestial Reference frame,
enabling the correct location of celestial objects.
If, for example, the Equatorial Coordinate System is the celestial reference system selected, then layers are located using the
angular positions Right Ascension and Declination.
These parameters enable the precise positioning of celestial objects, as well as simulate accurately the movement of the celestial sphere due to the Earth movements. For example, locate or
Figure 7.19: Set of parameters available after selectsimulate the movement of the Sun for a given location and date
ing the Astronomical Parameters group flag and the
can be achieved using these parameters (see examples).
option Use Astronomical Parameters.

Figure 7.20: The celestial sphere surrounding a dome. By enabling Astronomical Parameters, it is possible to
simulate the movement of the night sky.

7.4.1 - Use Astronomical Parameters
To have access to the Astronomical parameters, this option must be selected.
7.4.2 - Image Linked To
Here, it can be chosen whether a layer is linked to the Dome or to the Celestial Sphere:
- Observer (Earth): Images linked to the Observer will not move if the celestial sphere is animated, by keyframing
for example the time, in the Time & Date tab, see below, or if the location is changed. Layers will stick with the
dome.
- Celestial Sphere (Sky): Images linked to the Celestial Sphere will remain fix to the sky, but will move in the
workspace, the dome, if, for example, the time is animated or the observer location changed (see Example 4).
7.4.3 - Image Oriented To - Zenith / North Pole / Undefined
Allows to choose the orientation of a layer in a particular direction:
- Zenith: the top of the dome.
- North Pole: the North Celestial Pole.
- Undefined: no particular orientation (see below).
By default layers are oriented to the Zenith.
When Image Linked to is changed from Observer to Celestial Sphere, and vice versa, the orientation is kept and the Image Oriented to parameter changes to Undefined. This means that the layer will keep its orientation to the point in the
Celestial Sphere corresponding to the Zenith at the time of the change of the parameter Image Linked To. The inverse
also happens, in the sense that a layer initially oriented to the North Pole which has its Image Linked To parameter
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changed from the Celestial Sphere to Observer, will keep its orientation to the point in the composition, or dome, corresponding to the North Celestial Pole at the time of the change of the parameter Image Linked To.
7.4.4 - Observer Location
These fields set the observer location on the Earth:
- Longitude, ranging form 0º to 360º and is measured eastwards from the Greenwich meridian.
- Latitude, ranging from -90º to 90º. Measured from the
Equator, is positive to the northern hemisphere, negative otherwise.

Figure 7.21: Once Observer Location group flag is
selected, Longitude and Latitude parameters are displayed.

Figure 7.22: By changing the Latitude and Longitude the orientation of the inside sphere (Dome) relative to the outside
sphere (Celestial Sphere) is changed.

Both parameters can be animated and usually should be kept global, which means that if one has several layers linked to
the Celestial Sphere, their latitude and longitude should be connected. This can be done by setting an expression as shown
in section 6.2.
For a more advanced use, and seen through another perspective, these parameters allows the orientation of a sphere inside
another sphere, the dome and the celestial sphere, that opens very interesting possibilities.

7.4.5 - Time & Date
These parameters set the Time and Date. These are important
parameters for the astronomical simulation since, along with the
observer location, they establish the relation between the Observer (Horizontal) and Celestial frames.
These parameters should be animated if one wants to simulate
the aparent motion of the celestial objects, like Sun raising/setting.
They should be kept global, but care must be taken when animating the passage of time. The Extended Hours option
in the options field (see
below) should be disabled. For time animation, the use of the
Julian Date parameter is highly recommended.

Figure 7.23: Set of parameters available inside the
Time & Date group flag.
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The Input Parameters are:
- Date: Gregorian date - Day, Month and Year.
- Local Time: Local civil time.
- Time Zone: Difference in hours of the Local Time to the Universal Time. Increases towards the East.
- Local Sideral Time: Is the Hour Angle of the Vernal Equinox, defined as the ascending node of the Ecliptic on
the Celestial Equator.
- Julian Date: The number of days since noon on January 1, -4712, that is 1st January 4713 BC.
Some of these parameters are connected, so changing one the plugin will update the others.
7.4.6 - Coordinates
Selects the system of coordinates to be used, along with the
Epoch of reference.

7.4.7 - System
Several coordinate systems are implemented, namely:
- Equatorial:
Right Ascension, from 0 to 24h
Declination, from -90º to 90º
- Ecliptic:
Ecliptic Longitude, from 0º to 360º
Ecliptic Latitude, from -90º to 90º
- Galactic:
Galactic Longitude, from 0º to 360º
Galactic Latitude, from -90º to 90º
- Super Galactic:
Super Galactic Longitude, from 0º to 360º
Super Galactic Latitude, from -90º to 90º

Figure 7.24: Set of parameters available inside the
Coordinates group flag.

7.4.8 - Epoch
This parameter refers to the Epoch at which the coordinates
are referred to. The options are:
Current - Refers to the actual epoch defined by the date
in the plugin.
J2000 - Refers to the epoch currently used has standard,
which is 1st January 2000.
B1950 - Refers to the Besselian epoch of 1950.
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7.5 - Options
7.5.1 - Use nVidia Acceleration
If enabled, computers with nVidia graphics cards, can take advantage of GPU acceleration, with performance improvements
on the order of 10 fold when compared with the CPU. CUDA
installation is required, see section 3.5.
7.5.2 - Extended Degrees
If enabled, degrees can be inserted in the degrees (º), minutes (’)
and seconds (’’) format. Else, degrees will be in decimal format
(127,20º for example). Remember that 60’ is 1º and 60’’ is 1’.
This option should be disabled if we want to animate of the parameters expressed in degrees.

Figure 7.25: Set of parameters available inside the
Options group flag.

7.5.3 - Extended Hours
If enabled, hours are inserted in hours, minutes and seconds format. Else, hours will be in decimal format (15,53h for example).
This option should be disabled if we want to animate parameters
expressed in hours.
7.5.4 - Work Area limits
When off, this option disables the representation of the area outside the hemispherical workspace. This option is on by default.
7.5.5 - Colour Limits
Enables to choose a colour to represent the area outside the
hemispherical workspace. This is a useful reference. It is off by
default.
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8 - Examples
In this section several examples are explored in order to show the basic use of the Fulldome Plugin. It might be tedious for
a more advanced user but in the examples all the steps are described. Although here the use of the plugin is exemplified
with images, for video, the use of the plugin is similar.

8.1 - Example: Place an image in a composition at 45º Altitude

South with an Angular Width of 40º.

The image used here is in Figure 8.1a. It is a standard picture with a size of
1156x1408 pixels.
Initially the image needs to be brought to the composition:
- Create a square composition by selecting Composition > New Composition and set:
- Composition name (Comp1 by default).
- Width and Height (e.g. 1000x1000 pixels).
- Pixel Aspect Ratio - Square Pixels.
- Import the image to After Effects by selecting File > Import > File.
- Drag the image into the composition, Figure 8.1b. Since the image is
larger than the composition, some parts are outside the window.
- Apply Fulldome Plugin by selecting Effect > Navegar Foundation >
Fulldome. The plugin is applied to the layer, Figure 8.1c. By default:

Figure 8.1a: Image to import.

- The image is placed at the Zenith (Altitude 90º),
- The image in this location is oriented towards the South.
- Master Projection is Fisheye with a Spherical Angle of 180º.
- The Image Projection does not need to be changed, since by default
is Gnomonic, the standard image projection.
- Change the Altitude to 45º and the Azimuth to 180º, see Figure 8.1d. For guidance, on the Options parameter group, select Colour Limits and
set the colour to red.
- On Scale, set the Angular Width to 40º and the Angular Height changes accordingly. The angular proportions are maintained since Scale is set
at Lock Aspect Ratio parameter, and the Image Projection selected is
Gnomonic. Otherwise Angular should be set at Lock Aspect Ratio.

Figure 8.1b: Image imported to the composition.

Figure 8.1c: Plugin applied to the Layer. Figure 8.1d: Altitude changed to 45º and Figure 8.1e: Final result after setting the
Image at Zenith.
Azimuth to 180º (South).
layer Angular Height to 40º.
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Figure 8.2a: Image to insert is a panorama of a room’s child.

8.2 - Example 2: Insert a panorama into a composition.
The panorama to insert in a composition is 3398x427 pixels in
size. The idea is to bring the panorama to the composition and
place it accordingly and with the correct dimensions. The procedure should be:
- Create a square composition (follow the instructions in example 1).
- Import the image to After Effects by selecting File > Import
> File.
- Drag the image to the composition, Figure 8.2b. By default
the Master Projection is Fisheye with a Spherical Angle
of 180º.
- Change the Image Projection from Gnomonic to Panoramic Equal Distance. The image almost vanishes because
it is warped around the Zenith, Figure 8.2c.
- Set the Altitude to 0º and the central row of the image is
now located on the spring line, Figure 8.2d.
- On Scale, select Full Width Scale, and the image fully circles the composition. The Lock Aspect Ratio should be set
to Scale in order to maintain the proportions, Figure 8.2e.
- Increase the Altitude, to bring the bottom of the image, the
“floor”, to the spring line, Figure 8.2f. The Colour Limits
was selected and colour set to red, just for guidance.
A hole is present in the workspace centre, since the height of the
panorama image is not big enough compared with its width in
order to cover the entire 180º of the dome. A full 360º Panoramic
Equal Distance image has a proportion of 2:1.

Figure 8.2d: Altitude set to 0º altitude.

Figure 8.2b: Image inserted in the composition and after applying the plugin.

Figure 8.2c: Image warped around the Zenith, after changing the Image Projection
to Panoramic Equidistant.

Figure 8.2e: Image fully circles the compo- Figure 8.2f: Image raised, by increasing the
sition, after selecting Full Width Scale.
Altitude. The “floor” is now visible.
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8.3 - Example 3: Stitching images
When using 3D animation softwares, one of the common procedures to generate wide-field images, sometimes in extent of 180º,
is to use a camera rig, Figure 8.3a). This is usually composed of 6
cameras (up, front, left, right, back, down) each with 90x90º field
of view. At the end all the camera views need to be
stitched to
create a single image.
For each camera, the rendered images are square, Figure 8.3b. To
stitch the different images the user needs to place them in their correct position and set their size according to the cameras field of view
value set in the animation software.
This is done by:
- Create a composition, (see Example 1).
- Import to the After Effects composition an image obtained
in the rig, for example the rendered image of the camera
pointing up.
- Drag the image to the composition, and apply the plugin.
- Set Image Projection to Gnomonic (default).
- The image is already in its place, since the up image must
be located at (90º Altitude).
- On Scale, set the Angular Width and Angular Height to
90º. (By default, in the beginning the plugin indicates for
both angular dimensions a value of 90º. This is just an initial
reference value. Change one of them to any value, 91º for
example, and the angular dimensions become correct. Then
change it back to 90º). See Figure 8.3c.
- Drag a second image, the back one for example, set the
Angular Width and Angular Height to 90º, and change the
Altitude to 0º. The Azimuth is 0º by default, Figure 8.3d.
- Import and drag the remaining images, left, front, right and
down. Set their size to 90x90º. For the first three the Altitude
should be set to 0º, with Azimuth 90º, 180º and 270º respectively. The bottom one should have an Altitude set to -90º.
- A Full 360º image is ready, see Figure 8.3e.

Figure 8.3a: A Camera rig showing the setup with six different cameras of 90x90º.

Figure 8.3b: Image of the Sponza temple.
Rig camera pointing up.

Figure 8.3c: Composition after applying the Figure 8.3d: Composition after bringing the Figure 8.3e: The composition displaying all
Plugin and setting the Angular Width and back image to the composition.
the images in place, with the correct size,
Height to 90º.
perfectly stitched.
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8.4 - Example 4: The use of Astronomical Parameters.
It is often important to place celestial objects in the sky in a correct
position relative to the observer (horizon). To illustrate the use of the
Astronomical Parameters, a simulation of the daily movement of the
Sun is exemplified.
The date selected is 1 November 2006, the time 12h 00m and the observer is located in Espinho, Portugal, at Latitude of 41º 0’ 0’’ North and
Longitude 8º 35’00’’ West. From an astronomical ephemerides reference like the Almanac, the Celestial Equatorial Coordinates of the Sun
are for this date RA=14h 24m and Dec=-14.6º.
The first thing to do is to import to the composition an image of the
Sun:
- Create a composition.
- Import the image of the Sun to After Effects.
- Drag the image to the composition, and apply the plugin. The
image is a picture of the Sun taken by a Telescope, so the Image
Projection does not need to be changed since it is Gnomonic by
default, Figure 8.4a.
- The image was scaled to an Angular Width of 10º in order to
be noticeable in the figure, Figure 8.4b.
- Select Use Astronomical Parameters.
- Set the parameter Image Linked To Celestial Sphere. Usually
Astronomical images are oriented in such a way that the top is
towards the North, so the Image Oriented To was set to North
Pole.
- Insert the Location, Date and Time, as well as the Coordinates of the Sun for this date. The System is Equatorial. See
Figure 8.4c.
- Change Time to 6h 00m 00s, Figure 8.4d and add a Keyframe.
- On a different position in the time line change Time to 16h
00m 00s, Figure 8.4e.
Moving the cursor in the timeline, the image (the Sun) will change its
position in the Sky, displaying a Sun rise and set.

Figure 8.4a: Image brought to the composition and with the plugin applied.

Figure 8.4b: Composition after setting the
Angular Width to 10º.

Figure 8.4c: Composition after inserting the Figure 8.4d: Sun is rising in the composi- Figure 8.4e: Sun is setting in the compoLocation, Date, Time and Celestial Coor- tion after changing the time to 6h 00m 00s. sition after changing the time to 16h 00m
dinates.
00s.
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8.5 - Example 5: Fisheye image & size
Often the footage is obtained with a fisheye lens, covering a
large field of view. Let us look carefully to the image in Figure
12a. It is an image of the Litchfield Cathedral Lady Chapel.
Looking carefully at the image, it is possible to see the ground,
chairs on both sides, and two altars, one at the top and one looking further away at the bottom.
On the bottom part of the image, the view of the ground ends at
the altar, away from the image limits. The same happens on the
top of the image, although this second altar looks closer.
The fact that so much ground is visible in this fisheye image
all around the observer (camera) means that the image has an
angular size in excess of 180º.
Placing the image in a AAE composition, applying the plugin
and setting:
- Spherical Angle: 180º (default)
- Image projection: Fisheye.
- Azimuth: 180º.
- Scale: Angular Width and Height 180º

Figure 8.5a: A Fisheye Image of the Litchfield Cathedral
Lady Chapel (Credits: Mario Di Maggio, ThinkTank).

the image in Figure 8.5b is obtained, reproducing Figure 8.5a.
For a 180º Spherical Angle the scale of the image will be correct, when the far away ground (horizon) is at the spring line.
Setting the Angular scale to 220x220º the ground almost disappears, see Figure 8.5c.

Figure 8.5b: Image in Figure 8.5a after being inserted in a
composition and applying the plugin. See text above for the
parameters setting.

Figure 8.5c: Setting the Angular Scale to 220ºx220º, almost
all the ground from the image is hidden bellow the spring
line.
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8.6 - Example 6: Tilted Dome (15º)
Nowadays tilted domes are becoming quit common, and one of
the possibilities they offer to the spectator, is to look below the
horizon. The image in the previous example gives a very good
notion of this fact.
So lets start by placing the image in a AAE composition, applying the plugin and setting:
- Master projection: Fisheye (default).
- Spherical Angle: 180º (default)
- Image projection: Fisheye.
- Azimuth: 180º.
- Scale: Angular Width and Height 220º
Since the image angular size is 220ºx220º, for a 180º dome the
image extends to 20º below horizon. If a dome has a tilt less than
20º and the image is kept in the Zenith, the entire dome will be
filled by the image.
If the dome is tilted by 15º then, the user need to change the
parameter under the first group Dome (Figure 8.6a):
- Dome Tilt: 15º.

Figure 8.6a: Setting the Dome Tilt to 15º.

the previous composition the tilt is set to 15º.
The ground in the south direction (bottom part) becomes visible,
see Figure 8.6b.
In the dome, the visible structures in the image that extend themselves horizontally on both sides of the walls, will look horizontal, so a more natural view will be sensed by the viewer.

Figure 8.6b: After setting the Dome Tilt to 15º on the previous example (Example 4), the ground on the bottom of the
composition (South) become visible.

Figure 8.6c: A 3D view of image in Fig. 8.6a once projected
in a 15º tilted dome.
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8.7 - Example 7: Horizon Raising and Tilt
In this example, we will use a panoramic cartoon of the moon surface, see Figure 8.7a. When looking at the image, the
surface of the moon is visible, along with mountains in the background. The horizon line is at the middle of the image.

Figure 8.6a: A 360º panoramic cartoon of the Moon surface. Only a fraction of the entire image is shown.

The goal is to inserted the panorama in a composition so that
when projected it looks natural, like the displayed panorama
above.
First step is to import the image to a AAE composition and
set the basic parameters:
- Master projection: Fisheye (default).
- Spherical Angle: 180º (default)
- Image projection: Panoramic Equidistant
- Altitude: 0º
- Azimuth: 180º
- Scale: Full Width Scale
The composition will look like the image in Figure 8.6b.
As expected the horizon in the image will be placed on the
spring line, so no ground is visible, only the mountains. Although this is the correct view, in the sense that the horizon
is at 0º altitude, it does look a bit unnatural.
To sort this out, there are two possibilities: Raising the horizon or tilting it.
Raise the Horizon means raise the entire image together in
order to display parts of the image that otherwise were below
the spring line.
Setting in Dome group the Horizon Raise for something
like 10º, all the image is raised, and the ground becomes visible, see Figure 8.6c and Figure 8.6d.

Figure 8.6c: Setting the Horizon Raise to 10º.

Figure 8.6b: After placing the image at 0º Altitude, only the
mountain tops are visible.

Figure 8.6d: Raising the horizon the ground is now visible,
in a more natural view.
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If the Horizon Tilt is selected , the entire image will tilt. A
positive value means that the South will be raised and the
North (top) will be lowered.
In Figure 8.6f the effect can be seen, with the South part of
the image is now visible, and the back (North) part of the
image star to disappear.

Figure 8.6e: Setting the Horizon Tilt to 10º.

Figure 8.6f: Tilting the horizon the image raises on the
South part, while the North is lowered.
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8.8 - Example 8: Insert HD content
The use of HD content on the dome is becoming increasingly popular. To import into the composition HD content,
the natural procedure should be:
- Create a composition in AAE.
- Import the footage to the composition.
Set the parameters according to:
- Master projection: Fisheye (default).
- Spherical Angle: 180º (default)
- Image Projection to gnomonic (default).
- Altitude to 50º.
- Angular Width to 90º.

Figure 8.7a: HD image, 1920x1080 pixels in dimension.

In the example the Angular Width was set to 90º, just for
guidance. If the real angular dimensions of the image are
known, they should be set.
This produces an undistorded view of the content for a viewer placed at the Dome Centre. This means that such a viewer
will see the content as if were looking directly into image of
Figure 8.7a.
However, the user might want to have a different perspective, having the footage shown as a panoramic view. That is
close to what often happen in the cinema, when the spectator
is facing a curved vertical screen.
The user should:
- Import the footage to a composition.
- Set the Image Projection to Centre Panoramic.
- Altitude to 27º.
- Angular Width to 90º.

Figure 8.7b: Image placed at 50º altitude, using a standard
(Gnomonic) projection. The Scale Width was set to 90º.

In this case a different perspective is obtained, but care
should be taken, since if the angular width of the image is
large, it will tend to warp around the Zenith, producing high
distortions.

Figure 8.7c: Image placed at 27º altitude, using a Central
Panoramic projection for the image. The Scale Width was
set to 90º.
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8.9 - Example 9: HyperDome
Fulldome plugin is not limited to standard domes, hemispheres with an spherical angle of 180º. The possibility of
extending the spherical angle up to 360º can be used in several other areas, besides planetariums.
A good example is to produce Fisheye Off-Axis images,
that once projected with a fisheye projector can fill an entire
globe. Take for example an All-Sky image obtained by the
AKARI Satellite (http://www.ir.isas.jaxa.jp/ASTRO-F/Outreach/index_e.html).
To produce a Fisheye composition for an hyperdome of
360º, the user should
- Import the footage to a composition.
- Apply the Plugin.
- Set the Spherical Angle to 360º.
- Set the Master Projection to Fisheye Off-axis.
- Set the Image Projection to Aitoff.
- On Scale, select Full Width Scale.
The Fisheye image is 360º, and all the sky is visible. In this
image is possible to observe a very high distortion at the image limits.

Figure 8.8a: All-Sky image in Aitoff projection in the InfraRed taken by the AKARI Satellite.

Figure 8.8b: A Fisheye image with a Spherical Angle of
360º.

Figure 8.8c: A 3D view of the 360º Fisheye image projected
on a Sphere.
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Appendix A - Output Master Projections
The Master on Fulldome Plugin can be created in several different projections. Here, those projections are discussed in
more detail, mainly those with configurable parameters.

A.1 - Azimuthal Equidistant (Fisheye)
This is defined as the standard projection for fulldome, usually
called Fisheye. One of the properties of this projection is that the
linear and angular distances of a pixel to the image centre are
proportional. So points at the same angular distance to the centre
are represented by circles, see Figure A.1.
This is the projection to use when displaying content on the
dome using a projector with a Fisheye lenses, if the projector is
located at the dome centre, and the Spherical Angle is equal to
the Lens Aperture.

Figure A.1: A grid in a Azimuthal Equidistant projection
also referred as Fisheye projection. This is the standard
projection for fulldome.

A.2 - Azimuthal Equidistant Off-Axis
The Azimuthal Equidistant projection has the sweet spot at the
dome centre. However there are cases where it is important to
have this same projection, but placing the sweet spot away from
the dome centre.
A rather simple case is the output to be created for a fisheye
projector that do not have a 180º aperture lens. In that case the
projector should be located below the spring line, in order to be
able to fill the entire dome, and the projected content need to be
distorted accordingly, see Figure A.2.
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- Dome Radius: Radius of the Dome in meters.
- Lens Aperture: The lens aperture in degrees.
- Projector Position: The XYZ position of the projector
in the reference frame of the screen (dome), measured in
meters. The X axis points towards the North, the Y West
and the Z axis points up.
- Projector Orientation: The projector rotation angles,
Yaw, Pitch and Roll, measured in degrees. By default the
projector is pointing up, along the Z direction.
- Brightness: Activating the check box, the brightness
correction is activated to have a uniform distribution of
light on the screen.
- Projector Gamma: Gamma of the projector needed for
an appropriated brightness correction.

Sph

If this projection is selected a set of parameters, see Figure A.3,
become available to properly configure the required setup:

Figure A.2: Azimuthal Equidistant Off-Axis projection illustration. The Lens Aperture do not match the
Spherical Angle, so the projector needs to be located
below the screen centre to fill the entire dome.

35

FullDome Plugin V3.0 - Manual

Appendix - A

Figure A.3: Left: Parameters of the Off-Axis Fisheye that become available once this Master Projection is selected. Centre: A grid
corresponding to a set-up with the projector located below the dome centre. Right: The grid for an Off-axis projection, with the centre
located at the spring-line height, but moved half way towards the South of the dome. A very light grid is displayed on both centre and
right images in the background, corresponding to a standard Fisheye grid.

A.3 - Gnomonic
The gnomonic projection, also called standard projection, is
the one associated with traditional cameras, see Figure A.4.
Fulldome content producers are usually interested in the opposite, bring Gnomonic footage to a composition and create
a Fisheye Master Output.
So the Gnomonic Master Projection will enable the user to
extract standard images from other projections, like Fisheye
or other.

Figure A.4: A 90º by 90º gnomonic image Master
Output. The input footage is a Fisheye Grid.

A.4 - Stereographic
This projection, like the Gnomonic one, is a projective pro-

jection but with the viewer one radius of the dome away
from its centre, see Figure A.5.
It offers the possibility to project the entire dome, although
for Spherical Angle values close to 360º a significative distortion is present.

Figure A.5: A Stereographic Master Output, with
a Spherical Angle of 180º. For comparison a light
Fisheye grid is displayed on the background.
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A.5 - Orthographic
This projection corresponds to the view of the dome from an
observer located at infinity.
It is really helpful for those users that are creating content for
spheres, since this projection gives an excellent indication of
how the content will look like once projected.

Figure A.6: An Ortographic Master Output grid
with 180º of Spherical Angle. For comparison a
light Fisheye grid is displayed on the background.

A.6 - Vertical Perspective
The Vertical Perspective is the general perspective projection
that has the three previous ones, Gnomonic, Stereographic and
Orthographic as special cases.
Here the user has a parameter that need to be set, the escape
point. This parameter represents the distance, in units of radii,
which the projection point is away from the centre of the sphere,
see Figure A.7

Escape Point

Figure A.7: Vertical Projection setup, using a standard projector. The distance from the projector to the
dome has to be taken in account when producing
the master.

A.7 - Cylindrical Equidistant
The Cylindrical equidistant projection, or in lay terms the Cylindrical Projection, is highly used projection for panoramic
views.
Under this projection the angular distances on both directions, Altitude and Azimuth have the same length. For a complete 360ºx180º, the image proportion is 2x1, See Figure A.8.

Figure A.8: A complete 360x180º grid in a Cylindrical Equidistant Master Output projection.
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A.8 - Cylindrical Equal Area
When compared with the Cylindrical Equidistant projection, the Cylindrical Equal Area has the same behaviour on the
azimuthal direction, but in altitude it behaves like the ortographic projection, see Figure A.9.

Figure A.9: A complete 360x180º grid in a Cylindrical Equal Area output Master projection.

A.9 - Spherical Mirror
This ingenious output projection for fulldome uses a single
standard projector. The spherical mirror, due to the large distortions induced it is able to divert the light in such a way that fills
the entire dome (usually almost the entire dome).
This Master projection enables the necessary distortion for a
correct projection taking in account the reflection in the mirror.
One of the characteristics of this projection is its dependence
with the chosen set-up, including the need to compensate for a
nonuniform illumination of the dome. There are several parameters to take in account for a proper configuration (see Figure
A.10):
- Dome Radius: Radius of the Dome in meters.
- Mirror Radius: Radius of the Spherical Mirror in meters.
- Fit Output to: In general the projected image can only
fit the width of the mirror or its height at a time, since
the projectors are 4x3 or 16x9. Fitting the projected image to the mirror enables a maximum use of the projector
pixels. The options are:
- Width: Fit the with of the projected image with
the size of the Mirror.
- Height: Fit the height of the projected image
with the size of the Mirror.
- Both: Fit the with and height of the projected
image with the size of the Mirror.

Figure A.10: Parameters to configure the Spherical
Mirror Master Projection, that become available
once this projection is selected.

- Mirror Position: The XYZ position of the Spherical
Mirror in the reference frame of the screen (dome), measured in meters. The X axis points towards the North, the
Y West and the Z axis points up.
- Projector Position: The XYZ position of the projector
in the reference frame of the screen (dome), measured in
meters.
- Projector Orientation: The projector rotation angles,
Yaw, Pitch and Roll, measured in degrees. By default the
projector is pointing towards the Spherical Mirror centre.
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- Projector Film: This are parameters related with the displacement and scale of the frame. They are:
- Horizontal Off-set: Shift the image on the up-down direction.
- Vertical Off-Set: Shift the Image on the left-right direction.
- Zoom: Change the scale of the image. A value of one (1.0), means that beam of the projector fits exactly
the spherical mirror at the height or width according to the Fit Output to selection.
- Brightness: Activating the check box, the brightness correction is activated to create a uniform distribution of
light on the screen. Several parameters follow:
- Max Correction: The maximum correction on the light of a pixel. A value of ten (10) is a good limit.
- Projector Gamma: Gamma of the projector needed for an appropriated brightness correction.
- Fading Angle: Angle between the mirror centre and the points on the dome below which no brightness
correction is preformed.

Figure A.11: A grid displayed in a Spherical Mirror projection.
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Apendix B - Input Projections
In order to properly bring footage to the composition, the user needs to select the Image Projection suitable for the content that is being inserted.
The plugin has 14 different Image Projections implemented. Special attention should be paid to a few of them.

B.1 - Azimuthal Equidistant (Fisheye)
This projection should be used with content produced using fisheye lenses. This images usually cover the entire 180º of an
hemisphere, although sometimes even more. See Section A.1 for a more detailed description of this projection.

B.2 - Hammer-Aitoff
Projection used to represent the entire 360ºx180º view. It is commonly used to map the entire sky and in particular our
Galaxy. Close the Equator it behaves like a cylindrical projection, but lacking the large distortions close to the poles, see
Figure B.1.

Figure B.1: A Hammer-Aitoff projection of the WMAP. (Image credits: NASA /
WMAP Science Team)

B.3 - Gnomonic (Standard)
This is the standard projection. Should be use for content produced with a camera with a regular lens, or renders from a
3D animation software camera, see Figure B.2.

Figure B.2: A drawing in a standard (gnomonic) image projection.
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B.4 - Cylindrical Equidistant (Cylindrical)
Often referred simply as cylindrical projection, it is by far the most used cylindrical projection. For an entire sphere,
360ºx180º, an image in this projection has a proportion of 2x1. For an hemisphere its 4x1, see Figure B.3.

Figure B.3: A Cylindrical Equidistant image of the entire Mars surface
(Image credits: Caltech/JPL/USGS Caltech/JPL/USGS ).

B.5 - Panoramic Equidistant (Panoramic)
Also by simplification this is called Panoramic and should be used when inserting panoramic content. In many aspects it
works like the Cylindrical one, with the difference that the rows of the footage are always parallel to the spring line. In this
projection, the Altitude of the image corresponds to the position of the row at the image bottom, See Figure B.4.

Figure B.4: A panorama of the Martian landscape, captured by SPIRIT (Image Credit: NASA/JPL-Caltech/Cornell University )

B.6 - Spherical Mirror
In order to capture an extended scene, a spherical mirror can be
used. Its a set-up that basically reverses the dome projection one
(see Appendix A), with the camera in the place of the projector.
To properly configure this input projection, a set of parameters
need to be configured, see Figure B.5.
The parameters are the same as for the Master Projection, (see
Appendix A for a complete description). However there are a
few changes:
- Dome Radius: This should be interpreted as an average
distance to the objects in the scene. For an outside scene,
a large value should be used.
- The Mirror is considered to be in the centre of the reference frame.
Using a standard configuration to capture 360ºx90º, like in the
Spherical Mirror projection, the section of the scene on the back
of the mirror is not covered. In the same way, the image scene
reflected closer to the mirror edge have a lower resolution.

Figure B.5: The parameters to configure the Spherical Mirror Image Projection.
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Appendix C - Set up a Net Render using the Plugin
Fulldome Plugin has net render capabilities in order to speed up the rendering process. Several third party applications
are able to manage the net render of After Effects project. Here its described how to set up a net render using the resources
available in After Effects itself.
The first step to establish a net render is to install the plugin in all rendering computers.
Then the user should proceed according to the following steps:

1 - Send the composition to the render queue, selecting “Composition >
Add to Render Queue”, see Figure C.1.

Figure C.1: Send the composition to the render
queue.

2 - In the render queue options the output format must be set to render
in individual frames (by setting the output to JPEG, TIFF or any other
image format), see Figure C.2.

Figure C.2: Set the output to individual frames.
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3 - In the render settings tab of the render queue the “Use
storage overflow” check box must be unchecked and the
“skip existing files” option checked, see Figure C.3.

Figure C.3: Selecting Skip existing Files under the render settings.

4 - Save the project.

5 - In the “File” menu select “Collect Files”, see Figure
C.4.

Figure C.4: Selecting “Collect Files”
under File menu.
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6 - Select the “Enable ‘Watch folder’ render” option and
the “Change render output to” option, see Figure C.5.

7 - Press “Collect...” and save the new project in a folder
that is located in a network location accessible to all the
rendering computers, see Figure C.5.

Figure C.5: Set a folder accessible to all render nodes for the
location of the output render.

8 - The render engine must be started in all the computers,
from the network location where the project was saved.
That is achieved by choosing the “Watch Folder” option
in the file menu, see Figure C.6.

Figure C.6: Selecting the “Watch
Folder” to start the render engine.

9 - Select the network folder where the project was saved, and at this point After Effects will automatically scan for render
projects.
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